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Power BI Updates



User Research

Report Design & Data 
Prep

Performance Testing
Dashboard Design 
Prototype & Data 

Model MVP

Dashboard Design 
MVP

User Testing Authority to Operate

Power BI App and 
Data Set Published 

for Customers
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Power BI Implementation Milestones



5

Completed:
• Broad authentication testing
• User License report development
• Synthesize feedback from Time to Hire ideation sessions
• User License Power BI app released to onboarded customers, Job 

Aid, and Special Edition Release Notes published

In Progress:
• Infrastructure work for User License automated data refreshes
• Remaining Azure AD authentication work with DOD components, 

IRS, EOP
• Time to Hire dataset and report development
• Time to Hire data lakehouse pipelines

Next Steps:
• Identify Power BI Pro license holders (FY24-Q1)
• Host workspace administration session(s) (FY24-Q1)
• Release Power BI FAQs
• Collect User License app feedback (ongoing)

User Testing and 
Release

Next Steps
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USAS - User License App Demo



Once prompted, select your 
agency email address under 

“Pick an account.”

You will be notified on the 
screen to either approve or 

provide a code via the 
Authenticator app.

You can click Yes to reduce the 
number of times you are asked 

to sign in.
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Using the Authenticator App
The initial Authenticator app set up is a one-time action.

On future visits to connect.opm.gov, you will need to sign in using the Authenticator app. 

Your Agency Email

Notification Code
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USAS - User License App
The User License App enables simplified, detailed reporting on user accounts and permission profiles. The 

User License App dataset is updated once per day.

Select the Apps icon from the navigation panel or My apps from the tabs in the center of the page to display all of
your available Apps. Select USAS - User License to open the User License app.
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Favoriting an App
You can make commonly used apps even easier to locate by adding them to your favorites. To favorite an app, 

hover over the app row near the app name and select the star icon to “Add to Favorites.” These actions can also 
be done under the My apps tab on the Home screen or within the app itself.

Once added to favorites, the app will appear on the 
Home screen under the Favorites tab.

To remove a favorite, select the star icon again from the Favorites tab or My apps tab on the Home screen, 
from the Apps icon, or within the app itself.



10

Navigating within a Power BI App
Menu Bar

Report Page

App Navigation Pane



11

App Navigation Pane

Use the navigation pane to move to different report pages within the app 

Select Go back to exit the app and return to last visited screen

Collapse/expand the app navigation pane 

“User License Job Aid” provides in-app navigation to the User License Job Aid posted in the Resource Center
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Menu Bar Options (Left Side)

1. File > Print this page (opens Print menu); Generate a QR code (creates copy link)
2. Share > Copy link (only those with existing access can use link)
3. Export > Analyze in Excel (currently not available in connect.opm.gov); PowerPoint; PDF
4. Get insights: Currently not available in Power BI Apps
5. Subscribe to report: Send screenshot, link to report, and/or full report attachment as PDF or PowerPoint to email (self-only)
6. See related content: Shows related dashboards and datasets
7. View dataset: Displays last refresh information for the report's underlying dataset. Explore related reports that you have 

access to and create report from underlying dataset*

*Training will be offered in the future on how to create a report from a dataset in Power BI

Last refresh information for the report's underlying dataset.
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Menu Bar Options (Right Side)

Fit to page is selected by default. Use slider to zoom in and out of the page.

1. Reset filters, slicers, and other data view changes you've made
2. Personal bookmarks > Add a personal bookmark* or show more bookmarks on report page
3. Change view to full screen, adjust width to screen or switch to high contrast mode
4. Refresh visuals – only for data model changes
5. Comments are disabled
6. Favorite or unfavorite an app from here
7. Displays App Info 

*Training will be offered in the future on how to create bookmarks
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Report Page Header

Definitions:
• Each report page contains a data glossary 

with a description of the report page, data 
source, and definitions of each data item 
or measure used in the visuals on the 
page.

• The glossary is specific to each report 
page.

Feedback:
• Use the Feedback button to open an email 

to USAStaffingData@opm.gov to provide 
feedback on the User License app.

mailto:USAStaffingData@opm.gov
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User License Dataset & Row-Level Security

• The User License dataset currently excludes Retired and Excepted Users due to 
report performance impacts. There will eventually be a separate dataset developed 
to include Retired and Excepted Users.

• The dataset includes row-level security (RLS), which filters data to the row-level, 
restricting data access to only the data the user would see in the USA Staffing 
interface.

• RLS applies to the dataset when viewing the report in connect.opm.gov and when 
connecting to the dataset in Power BI Desktop to build a new report. 
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Report Page Slicers

To make multiple selections in a slicer, hold down the Ctrl button while selecting options. By default, the slicers are set 
to include all data. Use the Select all option to more efficiently make multiple selections by unselecting options. 

Slicers offer a way to filter visuals on the report page. 
The User License app has Tenant Code, Organization Name, and Office Name slicers on each page.

Hovering near the top of an individual slicer reveals the Clear selections button that will remove selections from that slicer. 
The Clear Filters button will clear selections from all slicers.
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Report Page Visual Interactions
Visuals on the report pages are interconnected. Selecting a data point in one visual will change all related visuals where 

that data point also appears. To de-select, click again on the selected value in the visual.

In this example, the organization, “Office of Personnel Management” was selected from the “Organization With License 
Overages” visual. This is indicated by the other columns becoming transparent. The large number tiles and “Days Since 
Last Login for Paid HR Users” visuals are cross-filtered and cross-highlighted to reflect licenses or Paid HR User counts 

specific to the selected organization.
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Paid Licenses Page

Slicers:
• Tenant Code
• Organization Name
• Office Name

Paid Licenses summarizes paid accounts and license allocations by Tenant Code, Organization Name, and Office Name for 
each user’s designated Primary Office.

Data Items:
• Allocated
• Days Since Last Login
• Licenses – Active Paid
• Licenses – Allocated

• Licenses Exceeding Allocated
• Licenses – Inactive Paid
• Licenses – Paid
• Row Count User Profiles
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Staffing Organization Page

Slicers:
• Tenant Code
• Organization Name
• Office Name

Staffing Organization provides user metrics related to paid and unpaid status and permission profiles by Tenant Code, 
Organization Name, and Office Name for user types who permissions are office-based (i.e., Human Resources, Reports 

Only, and Applicant Flow Data Only).

Data Items:
• Days Since Last Login
• Licenses
• Office/Customer Name

• Paid?
• Permission Profile Type
• Total Users
• User Type
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Staffing Office Permission Profiles Page

Slicers:
• Tenant Code
• Organization Name
• Office Name

Staffing Office Permission Profiles provides permission profile metrics as well as user level details by Tenant Code, 
Organization Name, and Office Name for user types whose permissions are office-based (i.e., Human Resources, Reports 

Only, and Applicant Flow Data Only).

Data Items:
• Offices
• Permission Profile Name
• Permission Profile Type

• Permission Profiles
• Primary Office
• Total Users

• User Full Name
• User Type
• Users
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Staffing Office Permission Profiles: User Details View
On the User Details view of the Permission Profiles report page, use the bar chart visual to filter the user detail tables at the bottom of the 

report page. 

Unpaid bar selectedPaid bar selected

All/Default (visual unselected)
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Staffing Office Permission Profiles: Permission Profiles View

On the Permission Profiles view of the Permission Profiles report page, use the bar chart visual to filter for Paid or Unpaid Permission Profile 
Types. 

All/Default (visual unselected)

Paid bar selected Unpaid bar selected
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Drill Through Reports & Contact Card
Drill through reports to more granular user details are available on each report page visual where the Organization Name, Days Since 

Last Login or User Type data items appear. The visual’s tooltip will indicate when a drill through is available. Right-click to drill through. 
Information displayed in the drill through report is contextual based on the part of the visual from where it is opened. 

In this example the User Details – Org drill through was 
opened from the “Never Logged In” column from the Days 

Since Last Login for Paid HR Users visual displaying the 6 users 
and their information.

An individual user Contact Card can be accessed from the User Details drill through report by right clicking on their Name or Email. Use 
the Back button to return to the original report page from any drill through report.
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Exporting Drill Through Reports
Drill through reports can be exported to Excel for further editing or analysis. After opening the User Details drill through report, select the 

More options menu by hovering near the top right corner of the report visual, select Export data leaving Data with current layout 
selected and select Export.



Resource Center
• Job Aids: Step-by-step Microsoft Authenticator App and User License Job Aids available 

(User License Job Aid also available within the User License Power BI app)
• Release Notes: USAS – User License Power BI App Special Release Notes available

https://help.usastaffing.gov/ResourceCenter/index.php/Reporting_and_Analytics

Need Help?
• If you need assistance or receive an error message, submit a Help Desk ticket through USA Staffing. 

Please send a screenshot of any error message received with the ticket.

Or send an email to USAStaffingData@opm.gov
25

Reporting Resources

HR Users
Submit a ticket through USA Staffing 

Report Author Only and AFD Users
Contact your internal USA Staffing Lead 
or Account Manager to submit a ticket 
on your behalf.

https://help.usastaffing.gov/ResourceCenter/index.php/Reporting_and_Analytics
mailto:USAStaffingData@opm.gov
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New Power BI Report Author FAQ



Q: With the release of the USAS - User License app, what else can I do with the User 
License data?
A: All USA Staffing reporting users are granted “build permission” to the app’s dataset, which allows users to 
create new reports in Power BI Desktop from the User License dataset. At this time, users can only publish 
reports to their My workspace and will not be able to blend data with their own agency data.
To access the User License dataset, open Power BI Desktop. In the Home tab, select Get data > Power BI 
datasets. Select User License – User Details and then Connect.
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New Power BI Report Author FAQ



Q: How do I get permission to author reports in Power BI? 
A: All users have permission to author reports in Power BI, however a Pro license is required to share 
reports with others using shared workspaces. We will be releasing a job aid and providing guidance to 
agencies in Q1 of FY24 on the identification of individuals that require a Pro license.
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New Power BI Report Author FAQ



Q: How do I get Power BI Desktop? Will USA Staffing provide it?
A: Power BI Desktop is a free, downloadable application from Microsoft. Anyone can download and use 
Power BI Desktop. See https://powerbi.microsoft.com/en-us/downloads/ for more information and to 
download Desktop. Coordinate with your agency’s IT support and follow applicable guidance to download 
and install the application, if necessary. USA Staffing cannot install Power BI Desktop for reporting users.

Q: How do I publish a report to My workspace?
A: After saving your report in Power BI Desktop, select Publish from the Home tab. Select My workspace for 
the destination. At this time, users are only able to publish reports to their personal My workspaces in 
connect.opm.gov. This is an optional step; users can work with the data within Power BI Desktop only.
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New Power BI Report Author FAQ

https://powerbi.microsoft.com/en-us/downloads/


Q: Where do I access My workspace?
A: After authenticating into Power BI through USA Staffing, select My workspace from the side bar menu on 
the home page. You can also reach My workspace from Workspaces > My workspace. It will appear at the 
top of the list of workspaces that you have access to.
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New Power BI Report Author FAQ



Q: Can I use Analyze in Excel to create refreshable reports in Excel?
A: The ability to connect to Power BI data that you can refresh directly inside the Excel workbook is 
currently not available yet in connect.opm.gov. We are working to make this feature accessible and will be 
providing training in the future. 

User-level static data can be downloaded into Excel by exporting drill through reports (see slide 21 for 
detailed directions).

31

New Power BI Report Author FAQ
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Cognos Performance Metrics



33

All ReportsFY23
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HDW ReportsFY23
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HDW New Hire Detail ReportFY23
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Time to HireFY23
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User LicenseFY23
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Cognos Training Program
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Available Trainings

8/1/2023

Who? • New USA Staffing reports 
users

• Report consumers • New report authors • Report authors

What? • How to navigate to and 
run reports

• Open forum to ask 
questions

• How to get started 
building reports

• Open forum to ask 
questions

Time? • ~4 hours • 1 hour • 1 ½ days • 1 hour

When? • Anytime! • The third Thursday of 
each month at 11:00 
AM EDT

• Monthly • The first Thursday of 
each month at 11:00 
AM EDT

How? • https://lcms.usalearning.
net/lcms/CustomerExtrac
tions/launch/1380/Cours
e4466/Launch.html

• All report consumers. 
Questions can be 
submitted in advance

• Contact your USA 
Staffing Account 
Manager to sign-up.

• All report authors. 
Questions can be 
submitted in 
advance

Report Consumer 
Training

Report Author 
Training

Advanced Author 
Forum

Cognos Consumer 
Forum

https://lcms.usalearning.net/lcms/CustomerExtractions/launch/1380/Course4466/Launch.html
https://lcms.usalearning.net/lcms/CustomerExtractions/launch/1380/Course4466/Launch.html
https://lcms.usalearning.net/lcms/CustomerExtractions/launch/1380/Course4466/Launch.html
https://lcms.usalearning.net/lcms/CustomerExtractions/launch/1380/Course4466/Launch.html
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Upcoming Trainings

8/1/2023

Dates Thursday, August 17
11:00 AM – 12:00 PM EDT

Thursday, September 21
11:00 AM – 12:00 PM EDT

Wednesday, August 23
10:00 AM – 3:00 PM EDT

+
Thursday, August 24

10:00 AM – 3:00 PM EDT

Thursday, August 3
11:00 AM – 12:00 PM EDT

Thursday, September 7
11:00 AM – 12:00 PM EDT

Thursday, October 19
11:00 AM – 12:00 PM EDT

Thursday, November 16
11:00 AM – 12:00 PM EDT

Tuesday, September 19
10:00 AM – 3:00 PM EDT

+
Wednesday, September 20

10:00 AM – 3:00 PM EDT

Thursday, October 5
11:00 AM – 12:00 PM EDT

Thursday, November 2
11:00 AM – 12:00 PM EDT

How to Register No registration required. 
Questions can be submitted 

in advance.
USAStaffingData@opm.gov

Contact your USA Staffing 
Account Manager.

No registration required. 
Questions can be submitted 

in advance.
USAStaffingData@opm.gov

Report Author Training Advanced Author ForumCognos Consumer Forum

mailto:USAStaffingData@opm.gov
mailto:USAStaffingData@opm.gov
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Reporting User Satisfaction Survey
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Reporting User Satisfaction Survey

8/1/2023

The bi-annual customer satisfaction survey launched on Tuesday, June 20 and closed on Friday, July 21.

We received the data from the survey late last week and are currently working on analyzing the results. 

Thank you to all those who took the time to complete the survey!

The survey is designed to gather in-depth and comprehensive feedback about products and services 
provided by the USA Staffing Reporting teams over the last 6 months, including: 

o Business Intelligence tool
o Data available for reporting
o Standard reports
o Interconnections

o Workgroups
o Training
o Support
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Modifications to Reports and Data Models

Sprint 51 deployed to Production on July 5
Sprint 52 deployed to Production on July 19

Sprint 53 will be deployed to Production on August 2
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New or Modified 
Reports

Hiring Data Warehouse Reports
Staffing Process Tracking Report – deployed July 5th

The Staffing Process Tracking Report was modified. This report displays 
request, vacancy, announcement, and certificate numbers as well as 
certificate review data and milestone dates in the staffing process for New 
Vacancy and Additional Selection requests. The report was modified to 
allow optional filtering of results by request customer name. 
• Team Content > USA Staffing Packages and Folders > Hiring Data 

Warehouse > Request
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Data Model 
Changes

Hiring Data Warehouse

New Hire Supervisor/Manager Email – deployed July 5th

A new query item was added to enable reporting on the email address of 
the individual identified as the supervisor or manager of a new hire.

New Hires folder > New Hire Information sub-folder
• New Hire Position query subject

• [Presentation View].[New Hire Position].[Supervisor/Manager Email]



46

Data Model 
Changes

Hiring Data Warehouse

JOA Reviewer Assignments – deployed July 5th

A new query subject and associated query items were added to enable 
reporting on the assignments given to a reviewer on a JOA review.

Vacancies folder > JOA Review Information sub-folder
• JOA Reviewer Assignments query subject

• [Presentation View].[JOA Reviewer Assignments].[JOA Reviewer Assignment]
• [Presentation View].[JOA Reviewer Assignments].[JOA Reviewer Assignment 

Completion Date/Time]
• [Presentation View].[JOA Reviewer Assignments].[JOA Reviewer Assignment 

Permissions]
• [Presentation View].[JOA Reviewer Assignments].[JOA Reviewer Assignment Status]
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Data Model 
Changes

Hiring Data Warehouse

Reviewer Assignments – deployed July 19th

New query items were added to the various reviewers query subject to enable 
reporting on the concatenated review assignments for specific reviewers.

Applicants folder > Panel Review Information sub-folder
• Panel Reviewers query subject

• [Presentation View].[Panel Reviewers].[Panel Reviewer Assignments]

Certificates folder > Review Information sub-folder
• Certificate Reviewers query subject

• [Presentation View].[Certificate Reviewers].[Certificate Reviewer Assignments]

Vacancies folder > JOA Review Information sub-folder
• JOA Reviewers query subject

• [Presentation View].[JOA Reviewers].[JOA Reviewer Assignments]
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Data Model 
Changes

Hiring Data Warehouse

Candidate Inventory – will be deployed August 2nd

Two new query items were added to existing query subjects to enable 
reporting on information and settings related to the new candidate 
inventory feature.

Applications folder > Application Information sub-folder
• Application query subject

• [Presentation View].[Application].[Candidate Inventory Opt-In?]

Vacancies folder > Vacancy Information sub-folder
• Vacancy query subject

• [Presentation View].[Vacancy].[Candidate Inventory Enabled?]
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Data Model 
Changes

Hiring Data Warehouse

Questionnaire Settings – will be deployed August 2nd

Two new query items were added to the existing Assessment query subject 
to enable reporting on questionnaire settings related to quality ranking 
factors and selective factors.

Assessment Packages folder > Assessment Information sub-folder
• Assessment query subject

• [Presentation View].[Assessment].[Quality Ranking Factor?]
• [Presentation View].[Assessment].[Selective Factor?]
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API Updates
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USA Staffing Data APIs
Snapshot Information
The following APIs were updated to allow users to identify the 
database snapshot the API is querying against. This snapshot 
information will enable users to identify when/if a refresh to the 
data has occurred.

• AFD Announcements API – deployed July 5th

• AFD Applications API – deployed July 19th

• AFD Vacancies API – deployed July 19th

• Assessments API – deployed July 5th

• Certificate Applications API – deployed July 5th

• Certificates API – deployed July 5th

• Customer API – deployed July 19th

• New Hires API – will be deployed August 2nd

• Offices API – will be deployed August 2nd

• Organizations API – will be deployed August 2nd

• Requests API – deployed July 19th

• Vacancies API – will be deployed August 2nd
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USA Staffing Data APIs
Reviews Endpoints – deployed July 5th

The Reviews API was updated to include two new endpoints.

• Reviewers API endpoint
• Allows users to pull a full list of reviewer data rather than 

pulling data by specific review ID(s). 

• Review Documents API endpoint
• Allows users to pull a full list of review document data rather 

than pulling data by a specific review ID(s).

Supervisor/Manager Email – will be deployed August 2nd

The New Hires API was updated to include an additional column for 
Supervisor/Manager Email.
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Open Demonstration and Q&A
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USA Staffing Reporting Upcoming Events and Releases

August 1 Special Release – Power BI: User License

August 2 Reporting Production

August 9 Reporting Stage

August 16 Reporting Production

August 23 Reporting Stage

August 30 Reporting Production

August 1 Reporting and Analytics Workgroup

August 3 Advanced Author Forum

August 17 Cognos Consumer Forum

August 23-24 Cognos Report Author Training

September 7 Advanced Author Forum

September 19 Reporting and Analytics Workgroup

September 19-20 Cognos Report Author Training

September 21 Cognos Consumer Forum

Events

Releases

The full USA Staffing Release Schedule and Release Notes can be found on the USA Staffing Resource Center.

https://t.e2ma.net/click/wwahrf/0vknbov/c53lmq
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Resources and Contacts

8/1/2023

IBM Cognos Analytics User Guide
The official IBM user guide for Reporting via Cognos Analytics: 
https://www.ibm.com/support/knowledgecenter/SSEP7J_11.0.0/com.ibm.swg.ba.cognos.ug_cr_rptstd.doc
/ug_cr_rptstd.pdf?view=kc

USA Staffing Resource Center
Under the Reports and Analytics section, you’ll find presentations from previous workgroup sessions and other 
resources: https://help.usastaffing.gov/ResourceCenter/index.php?title=USA_Staffing_Resource_Center

Need Help?
If you are experiencing issues accessing Cognos or need help to create or troubleshoot a report, submit a 
HelpDesk ticket through USA Staffing. If you are unable to submit a HelpDesk ticket, please contact us at 
USAStaffingData@opm.gov

https://www.ibm.com/support/knowledgecenter/SSEP7J_11.0.0/com.ibm.swg.ba.cognos.ug_cr_rptstd.doc/ug_cr_rptstd.pdf?view=kc
https://www.ibm.com/support/knowledgecenter/SSEP7J_11.0.0/com.ibm.swg.ba.cognos.ug_cr_rptstd.doc/ug_cr_rptstd.pdf?view=kc
https://help.usastaffing.gov/ResourceCenter/index.php?title=USA_Staffing_Resource_Center
mailto:USAStaffingData@opm.gov
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